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How to use Acrobat Reader

Welcome to this electronic publication!
Adobe Acrobat Reader gives you exceptional control in accessing the information in this book.
The following information* is provided to assist you:

Viewing Options

The publication opens with the navigation window displayed at the left. This window contains
"Bookmarks" (text) and "Thumbnails" (pictures) to assist in navigation. Use the appropriate buttons
on the command bar to view either Thumbnails or Bookmarks, or to collapse this window. You
may also select these options under "Window" on the menu bar or you may click the Bookmarks
or Thumbnails tabs at the top of the navigation window.

The navigation window can be widened or contracted by dragging the two small triangles at the
bottom of the right border of this window.

Control the viewing size of the pages in this publication by selecting any one of the page buttons
on the command bar. Options include full magnification, fit the page in window, and fit the visible
width of the page in window. As an alternative, use the viewing selections under "View" on the
menu bar. The zoom-in (magnifying glass) button on the command bar can be used to zoom in
and out of any area on a page.

* These instructions apply to Acrobat Reader 4.0. Minor variations may exist in version 3.0
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Navigation

1. Use the triangle (arrow) buttons on the command bar to view the next page or the previous page.
You can also return to "the previous view" or go to the first or last page.

2. The menu bar can be used to navigate. Choose View > Next Page or the destination of your choice.

3. Click on any bookmark in the navigation window (at the left). Click on the sideways triangle (right
facing arrow) to open the bookmark header and to view other bookmarks in this category. You may
also click on any thumbnail in the navigation window.

4. Custom red triangles (arrows) have been added to some of the pages. Click to link to related
information and/or more pages.

How to Find Things

1. Click the find tool (binoculars) on the command bar, or choose Tools > Find on the Menu bar. A
dialog box will appear. Enter the text to be found and click Find. When the program finds the text, the
Find dialog box closes and the page containing the text is displayed with the text highlighted. This
command will only locate one occurrence.

2. If you want to find out if there are more occurrences of the text, press Ctrl (Windows and UNIX) or
Command (Macintosh) +G, or on the Menu bar, Tools> Find Again. You may also reopen the Find
dialog box and click Find Again. With Windows, pressing F3 also finds the next occurrence.
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Computer Colors

This publication was designed for electronic distribution and computer viewing. The layout, fonts and
colors were chosen for this environment. Every effort has been made to reproduce colors accurately.
All illustrations were prepared on a system with full gamma correction and color synchronization.

Note!
Colors may vary on different computer systems.
Anti-glare screens will cause color distortions.
16 - 24 bit color, a high quality monitor and fully corrected gamma deliver the best results.

Windows PCs do not have built-in color correction and typically require a
video or graphic card for accurate color readings and full gamma correction.

About Color Printing

This publication was designed for on screen viewing using the RGB color model. Printers use the
CMYK (cyan, magenta, yellow, black) color model. Therefore, colors on your computer monitor will

appear different when printed with CMYK inks. Warning: Printing this publication will consume a
large quantity of ink!
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About Color Voodoo

Like voodoo, color can sway thinking, change actions, and cause reactions.

Red means "stop" and green means "go." Traffic lights send this universal
message. Likewise, the colors used for a logo, business card, product,
packaging, web site, interior design, architectural elements, or clothing cause
powerful reactions. Color sends a subliminal message, one which plays a
critical role in success or failure. It will either attract or distract, work for you
or against you.

The subliminal power of color is serious business. Consequently, the
information in this book is presented in a methodical way. You might think the
tone is a bit academic, but it will deliver clear concepts about color symbolism
so that you can use it to your advantage.
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Notation about the color illustrations

The color swatches in this publication are based on the 216 colors which are common to
both Windows and Macintosh computers and can be viewed on 8 bit (256 color) monitors.

Every effort has been made to reproduce colors accurately. All illustrations were prepared
on a system with full gamma correction and color synchronization.

Colors may vary on different computers. Anti-glare screens may cause color distortions.

The color swatches must be viewed on a system with full gamma correction.
A high quality monitor is essential. PCs may require a video or graphic card

for accurate color representations.

Fully corrected gamma of 1.8 is built into Macintosh computers, Silicon Graphics workstations,
and machines running NeXTStep. Older monitors may alter color accuracy.
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Color Models

Monitors and printers reproduce colors differently. Monitors use
the red, green, blue (RGB) color model. Printing is based on
the cyan, magenta, yellow, and black (CMYK) color model.
Colors on-screen may look different when printed.
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Design Applications

The color information and illustrations in this publication will assist in developing a successful
color scheme for all areas of design. Since these illustrations and color formulas are based on the
RGB color model, variables may occur when using other color systems. The following provides
important information about these variables:

Labels, Packaging, Business Cards, Stationery and Signage
The RGB values of the colors may be used as a reference for appropriate specifications for
printing and other media.

Products
The RGB values may be used as a reference for enamels, glazes, paint, textile dyes, and other
color media.

Wardrobe

The color swatches may be used as a reference for wardrobe selections.

Note: The special information about the gender based appeal of the red family of colorsis especially
useful for color communication in wardrobes.
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Interior Design and Architecture

The color swatches may be used as a departure point for interior or exterior color schemes.
Caution should be used in paint and wall covering selections. The colors of the swatches in this
publication will be quite different when applied to large interior or exterior surfaces. Muted colors
will wind up looking much more colorful. Some colors may turn out too pale, others, too dark.
Consult with a paint representative and/or a design professional. Large brush-outs will give you a
better idea of end results. Similar caution should be used when selecting carpeting and other
elements which cover large areas.
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Web Site Design Applications

The color information and illustrations in this publication are specifically applicable to web
site design. All web site graphics (gifs and jpegs), background colors, text and link colors are
based on the RGB color system. Since this is an electronic publication, the same RGB color
system was used for all color illustrations. What you see in this publication is an accurate
representation of web site colors, one which will help you develop successful colors for web
site design.

The HEX code is included for each color swatch. This may be used to specify background
colors, text, or link colors in html documents. The RGB values are also supplied and may be
used for non-dithering colors for graphic illustrations.

Since these illustrations and color formulas are based on the RGB color system, variables

may occur when using other color systems. If you print this publication, the colors may deviate
from their on screen accuracy.
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Tips for Color Communication - Global Design & Web Sites

1. Know your target market.

As a case study, let's assume you’re selecting colors for a bank. Financial institutions require
colors which support a sense of security, trust and reliability. The color of currency also comes
into play. A risky color would be purple since many of its primary associations are related to the
intangible world of creativity, spirituality, mystery and the sub-conscious. Nevertheless, if that
financial institution is located in Charlotte North Carolina, the home town of the famed Charlotte
Hornets basketball team, whose colors happen to be purple and teal, and if the membership of
that bank is primarily female, purple combined with another color is worthy of consideration.

As a general rule of thumb, you have a lot more flexibility in color selections for a regional business.
If, on the other hand, the business intends to expand its base nationally or globally, off-beat color
selections should be avoided.

2. Use extreme caution with global audiences.

When designing for a global market, designers must subject their color selections to stringent
cross-examination. If a color's symbolism does not support the fundamental characteristics of a
product, service, person or place, and if it is insensitive to a specific culture, that color may
communicate in surprising ways. }
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Consider again the color purple. It may work as a symbol of creativity for art and as a symbol of
the extra-terrestrial for science fiction, but it's a polarizing color. People either love it or hate it.
Furthermore, it's potentially hazardous on a global level. It may symbolize mourning and death in
many cultures in the same way that black does in American culture.

A significant example of purple failure is the initial design of EuroDisney’s signs. The color palette
was intended to rival Coca Cola’s red, but the final selection of vast amounts of purple was a
tragic mistake. Purple symbolizes death and the crucifixion in Catholic Europe. It's not surprising
that visitors thought the signs were morbid. How did this happen? The CEO liked purple. [1]
Personal preference and “avant-garde” tactics frequently cause color disasters. When the wrong
color is used on a web site, the damage extends to a global audience.

[1] Euroclash, ID Magazine, January 1992, p.61

3. Use caution with “in” colors.

Just because a certain color is a color marketer’s “in” color for the year (or next year, or the
decade) doesn’'t mean it will work for everything and it certainly doesn’t mean that it will work
globally. The late 20th century bore witness to the popularity of yellow-green which ranged in hue
from a soft avocado-green to an acidic lime-green. It infiltrated fashion and home furnishings in
American culture. Print advertising, television and web sites embraced it for a “cutting edge” look.
The more acid the hue, the more it became an “in your face” symbol of the avant-garde. b
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In spite of this, most shades of yellow-green do not enhance the image of baked goods, toothpaste,
cosmetics or gastro-intestinal products. Consequently, this color would only add negative or
confusing associations.

4. Don’t use personal preference.

The most common color mistake is selecting a color because you like it. Some people will argue
that they feel very comfortable with a certain color or that they like the way it looks in a certain
context. One designer fell in love with the aqua and yellow color combination of Bahama's license
plates. He proceeded to use these colors as the core color scheme on a web site for a paper
manufacturer located in Maine. Not by any stretch of the imagination do these colors support this
product. They serve only to confuse the viewer, thus discouraging exploration of the web site.
Surround yourself with your favorite colors but remember, color communication is a science.
Objectively analyze the product or theme of your project. (Advise your client to do the same!)

5.When in doubt, don't.

Most people have an intuitive warning system. If you're feeling a little queasy about a color
selection, chances are it's wrong. Test it out by selecting a color one step removed such as a
blue-green instead of a blue. You may be close to your mark or way off! b
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6. When in doubt, stick to timeless symbolism.

The timeless psychological associations and natural references of any given color should be
foremost. For example, red is the color of fire and blood. Psychologically it is a dynamic energizing
color. It is far removed from any symbolic association of serenity or dependability.

(Refer to the text descriptions in this publication.)

7. Prepare for color mutations on the web.

Think about the last time you were in an electronics store and viewed dozens of television sets in
a row. The picture was darker on some sets, the contrast varied, and, on closer examination you
may have noticed that flesh tones and even the colors of the trees and sky were different. The
possibility for color mutations is even greater in web site design.

Here’s what you can do:

a. Make sure your computer has good color vision.

Start by establishing the best color standard in your computer's operating system. If you're
designing on a PC (Windows), correct your gamma by buying the best components and
components that work well together. If you're designing on a Mac or SGI workstation, sufficient
gamma correction is built into your system. Beware of anti-glare screen devices.
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b. Use the 216 web color palette.

Although each browser has a vocabulary of 256 colors, only 216 colors are common to both PCs
and Macintosh computers. Using a web-safe palette will ensure that the colors you select are
standard on all computers and all Web browsers. Also, if you select colors outside of the 216
palette, the color may consist of speckles of colors. This effect is called dithering and can cause
severe problems in background colors, text, and all link colors. Note: This palette does not mean
that the color you select will look exactly the same on all computers. Colors are generated by the
computer's operating system and monitor, not the palette. Nevertheless, the 216 web-safe colors
are a very reliable standard.

(Note: All colorsin this publication are part of the 216 color web-safe palette.)

c. Foresee the variables on other computers.

Preview your work on several different computers. If you’re on a Mac, check out your designs on
a Windows PC with 256 colors (8 bit). You may be surprised by the relative darkness of your hues
as well as non-linear color shifts. Teal greens may appear much bluer, sandy beiges may shift into
peachy tans. If you're on a PC, chances are you'll be amazed at how much lighter colors are on a
Mac. The previously described color shifts will also be evident.
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Introduction to Color Symbolism

Nature provides a significant starting point for color symbolism. Natural references, such as fire
and water, play a powerful role in the symbolic meaning of the respective colors. This symbolism
can be considered timeless. Other symbolic meanings change over time and are considered
timely. These are linked to politics, fashion, religion, myths, and geography.

The color symbolism in this publication is based primarily on Western culture. In some situations,
different countries in the Western world may attach different meanings to some colors. The colors
of the nation’s flag, the colors of a nation’s sports team, and other conventions will affect the
symbolism of certain colors. For example, the symbolism of orange will be quite different in the
Netherlands, where the Royal House is referred to as “The House of Orange.”

Much of the information about color symbolism comes from data gathered from "The Global

Color Survey" located at the Color Matters web site. This database consists of thousands of
entries from all points on the globe.
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Categories of Color Symbolism

The first category, "References in Nature," includes natural elements that one would find at any
time on Earth.

The second category "Psychological Symbolism," includes positive and negative associations.

Other symbolic categories that may be applied to a color, include:

"Contemporary Culture" (objects and associations that have evolved in the Twentieth Century),
"Religious,” "Historical / Political,” "Other Cultures,” and "Fashion.” These categories are included
only when they are relevant to a color.

Of special note are the color codes from OSHA (Occupational Safety and Hazard Administration).
Although this an American standard for industry, there are significant similarities to psychological

and natural associations.

A list of idiomatic expressions in American English is also included as a final reflection on
symbolism.
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THE SYMBOLISM OF RED

Psychological Symbolism References in Nature
energy fire
warmth blood
strength raw meat, flesh
impulse roses, carnations, and other flowers
dynamism apples, berries, tomatoes, and other fruits
activity cardinals and other birds
courage rubies and other gemstones
excitement
love Contemporary Culture
passion o ) ) ,
dominance t_rafflc Ilghts gnd signs desgnatlng “Stop”
: fire engines in many countries
rebellion _ )
aggression associated W|th the planet Mars
war and combat hea.rts (Valentines Day)
violence Christmas
sexuz_;lllty Religion
prostitution
the devil
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Historical / Political Associations
associated with communism in the 20th century

Other Cultures
an important color in China and Japan

Fashion
attention getting, sexy

OSHA Coding
Red: danger, stopping, fire protection equipment

Optics
Red advances, thereby creating the impression that
red objects are closer than they are.

Etc.

Reds are classified as yellow-based or blue-based.
Yellow-based reds, such as tomato, appeal to males.
Blue-based reds, such as raspberry, appeal to females.

Swatches
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THE SYMBOLISM OF PURPLE

Psychological Symbolism References in Nature

spirituality orchids, irises

mysticism grapes, plums

magic cabbage

faith purpura shellfish (from the Mediterranean)
the unconscious (Note: purple very rarely occurs in nature)

dignity

mystery Contemporary Culture

creativity

awareness Purple Heart

inspiration (American military award for bravery)
passion

|mag_|r_1a_t|on Historical/Political Associations
sensitivity

aristocracy and royalty the imperial color of ancient Rome
conceit

pomposity

cruelty

mourning

death More b

Color Voodoo #1 - A Guide to Color Symbolism



Fashion

associated with mourning in some Western and
Eastern cultures

OSHA Coding

Purple: hazardous nuclear energy

Optics/Physiology

the hardest color for the eye to discriminate

Swatches
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Psychological Symbolism References in Nature
spirituality sky
trust oceans and lakes
truth blueberries
cleanliness bluebirds
tranquility fish
contentment mold
immateriality blue bonnets and other flowers
passivity lapis and other gemstones
understanding Note: blue is not commonly found in natural objects
conservatism
security Contemporary Culture
technology
masculinity denim (blue jeans)
coolness and cold Police uniforms (U.S.)
introversion IBM - Big Blue
melancholy
depression
More b
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Historical/Political Associations

the color of robes representing the station of
philosopher in ancient Rome
signifies spiritual and pacific virtue in Christian art

Other Cultures

the color of immortality in China
the color of holiness for Hebrews
the color of the god Krishna in Hinduism

OSHA Coding

Blue: cautions against the starting, use, or
movement of equipment under repair

Optics/Physiology

Blue recedes, thereby creating the impression that
blue objects are farther away than they are.

Swatches
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Psychological Symbolism

nature
growth
fruitfulness
renewal
freshness
tranquility
hope
youth
health
peace
good luck
coolness

envy
immaturity

References in Nature

all vegetation

lakes and other inland waters
emeralds, jade, and other gemstones
birds

fish

Contemporary Culture

traffic lights designating “Go”
ecology and conservation
American money (greenbacks)
Christmas

THE SYMBOLISM OF GREEN
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Historical/Political Associations

Celtic myths: the Green man was the God of fertility

Fashion

favored by sophisticated Europeans for a long time
avocado greens: popular in the ‘60’s in the US
stable pure shades of green: the color of the ‘90’s

OSHA Coding

Green: used for designating safety and locations of
first aid equipment

Optics/Physiology

the most restful color to the eye

The lens of the eye focuses green light exactly on the
retina.

The range of green hues is very broad.

Swatches }
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THE SYMBOLISM OF YELLOW

Psychological Symbolism

cheer

hope

vitality
luminosity
enlightenment (mental and spiritual)
communication
expansion
optimism
philosophy
egoism
dishonesty
betrayal
cowardice
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References in Nature

sunlight

sand

autumn leaves

corn, squash, and other vegetables
lemons, bananas, and other fruits
sunflowers, daffodils, and other flowers
canaries and other birds

fish

gold, topaz and other gemstones
human hair and animal fur

urine, phlegm, pus, jaundiced skin

Contemporary Culture

traffic lights and signs designating slow or
caution

taxis (Yellow Cab-U.S.)

quarantine flags

butter, mustard and spices
More b



Religion

Deities in Greek mythology had yellow hair
and robes. (Therefore, it was not popular
with the early Christians.)

Historical/Political Associations

Yellow Fever

Other Cultures

a symbol of the emperor in China
a sacred color in Hinduism

the color preferred by Confucius
an important color in Early Egypt
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OSHA Coding

Yellow: cautions against physical hazards,
such as projections

Optics

the color the eye processes first
the most visible and luminous color of the
spectrum

Swatches P



Psychological Symbolism

energy
cheer
activity
excitement
warmth
crassness

OSHA Coding

Orange: designates dangerous parts of
machines or energized equipment which
may cause injury

References in Nature

fire

sunset

oranges, mangoes, apricots, and other fruits
pumpkins, yams, and other vegetables
flowers and autumn leaves

goldfish

human hair and animal fur

Contemporary Culture

life rafts

copper

symbolizes that a product is inexpensive (U.S.)
Halloween (U.S.)

school buses (U.S.)

Historical / Political Associations
The Royal House of the Netherlands is referred
to as the House of Orange

Swatches
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Psychological Symbolism

nature
durability
reliability
realism
warmth
comfort
homeyness
boredom

Contemporary Culture

chocolate

coffee, cola and other beverages
rice, grains

sugar

tobacco

UPS trucks

THE SYMBOLISM OF BROWN

References in Nature

earth

tree trunks

roots

rocks

autumn leaves
cooked meat
human hair and skin
animal fur

birds

fecal matter

Etc.

Note: Although browns are very muted versions of
oranges and reds, the swatches are grouped
independent of the parent colors. In some cases,
the dividing line between a muted orange and a
brown isnot rigid.

Swatches )
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THE SYMBOLISM OF BLACK

Psychological Symbolism

power
sophistication
sexuality
the unknown
the end of a cycle
(after the fire, after the day, comes the dark)
death
corruption
ominous forces
emptiness
depression

References in Nature

the darkness of night, absence of light
rocks

hardened lava

charred wood and other objects

soot

crows and other birds

the pupil of the eye

human hair and animal fur

onyx, slate and other minerals

Contemporary Culture

ink
cast iron and other metals
industrial machinery

More b
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Religion

the color of the Christian priesthood, representing
self-denial
evil forces

Historical/Political Associations

the color of the Egyptian God Osiris, representing
the seed of life that grows in the dark

the Black Plague

Black Panthers (U.S. Militant Organization)

Fashion

power color
the color of mourning in many Western cultures

Etc.

In subtractive color theory, black is the result of the
combination of all colors.

Swatches P
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THE SYMBOLISM OF WHITE

Psychological Symbolism References in Nature
purity the non-color of light
cleanliness clouds
truth snow
innocence sea foam
chastity flowers
spirituality doves and other birds
sophistication opals
refinement teeth, hair, whites of the eyes
newness animal fur
blandness cooked meat (chicken) and fish
sterility
death Contemporary Culture
the white dove of peace
the “White House”
(presidential residence in U.S.)
processed food
(white bread, rice, sugar, etc.)
detergents More "
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Religion Optics/Physiology

salvation Pure white can produce glare and cause
the holiness of the God figure optical fatigue when used in large
the purity of the priesthood quantities.

Etc.

Historical/Political Associations
In additive color theory, white is the result of

the color of the flag of surrender the combination of all colors of the spec-
the color of mourning in ancient Rome & trum.

medieval France
Fashion

wedding gowns symbolizing chastity

the color of mourning in some Western and
many Eastern cultures

uniforms for doctors and nurses

Swatches
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THE SYMBOLISM OF GRAY

Psychological Symbolism References in Nature
neutrality rocks
intelligence smoke
futurism clouds (stormy or overcast skies)
modesty shadows
technology human hair
secure
liberalism
tranquility
cold Contemporary Culture
retirement
indifference concrete
sadness silver, platinum, steel and other metals
decay industrial machinery
dreariness
Optics/Physiology
the simplest color for eye to see
Swatches
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Red

red-blooded ( hearty, healthy)

red-neck (low class, uneducated)

red light district (prostitution)

to be caught red-handed (with evidence)
to be in the red (in debt)

red tape (a mire of details)

red ticket item (a special item)

a red letter day (a fantastic day)

Green

green thumb (good gardening abilities)
green with envy

green around the gills (sick)

green behind the ears (immature)
green alien beings

IDIOMS IN AMERICAN ENGLISH

Although idiomatic expressions are representative of the culture from which they arise, they
demonstrate significant associations, many of which reinforce the general psychological symbolism
of specific colors. The following represents a sampling of idioms in American English.

Blue

blue chip stocks (solid, profitable)

singing the blues (songs with melancholy
lyrics)

feeling blue (sad, depressed)

blue laws (puritanical conduct laws)

blue collar worker (laborer)

blue ribbon (the highest award)

blue blood (aristocratic)

blue streak (fast movement)

blue lightning (fast movement)

blue book (a publication listing car prices)

out of the blue (unexpected)

Purple
to turn purple with rage More |
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Yellow

yellow press (unscrupulous, sensational
journalism)

to be yellow (cowardly)

to have a yellow streak (cowardly)

yellow-bellied (derogatory, cowardly)

White

white magic (good, kind)

white lies ( falsehoods for a higher purpose)

white collar worker (professional, upper
class)

to white wash (cover up)

Brown

to brown bag (to bring your lunch)

brownie points (credit gained by flattering
someone)

to brown nose (to flatter someone for per-
sonal gain)

Gray

gray areas (shadowy areas or concepts that
lack specificity)

seeing things in shades of gray (with an open-
mind)

gray matter (the brain)

Black

black magic (evil)

to be in the black (making a profit)

to put someone on a black list (a list of
undesirable / rejected people)

black sheep (a member of a family or
group who is a disgrace)

little black book (an address book listing
special people)

black ball (cast a negative vote against
someone)

black list ( a list of persons who are disap-
proved of and are to be punished)

black market (illicit trade in goods)
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COLOR SWATCHES

Color codes & formulas
About the layout
About the terms used

Red Swatches
Purple Swatches
Blue Swatches
Blue-Green Swatches
Green Swatches
Yellow Swatches
Orange Swatches
Brown Swatches
Black & White Swatches

Gray Swatches
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Color Codes and Formulas

The color swatches in this publication were selected from a set
of colors which are common to both PC and Macintosh
computers. The RGB formulas and the HEX code (for web site
HTML specifications) are on the left side of each color swatch.

R: 000
G: 255 | =—— The RGB (Red, Green, Blue) formula

B: 204
O0FFCC -+—— The HEX code for web site design

Refer to "Design Applications” for related information. }
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About the layout of the swatches

The colors in this publication are divided into the following
groups: red, purple, blue, green, yellow, orange, brown,
black, white and gray. In some cases, the dividing line
between the color groups is quite fluid and can not be
considered an absolute. The primary focus is on the
symbolic descriptions of each color rather than on a rigid
positioning.

The colors are arranged in chromatic order. For example,
greens begin with "teal green” (a green with a slight blue
cast), progress to pure green, and end with olive green (a
green with a yellow cast).

Similar versions of the same color are grouped sequentially.
These groupings may include a light version, a medium
version, a dark version, a bright version and a muted
version of the same "parent"” color.
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About the terms used

The English language does not support a wide range of color terms beyond the names of basic
hues, such as “red” and “blue.” In addition to the basic color names, colors may also be described
by references to naturally occurring objects, such as “burgundy” or “lime”. Designer color terms
such as “Antique White” and “Riviera Blue” are not accurate and are not used in this publication.

In order to differentiate each color, the following descriptive terms are used:

Dark - a dark version of the color, one which is a “shade” of the original color

Medium - a medium or medium-light version of the color

Light - a light version of the color, one which is a pastel or “tint “ of the original color
Muted - a dull, less colorful version of the color

Bright - a very pure, very intense, very saturated version of the color

Deep - a very rich version of the color, a full bodied color in spite of its relative darkness

Some colors may also be described with terms such as “yellow-based” or “blue-based.” For example,
atomato red is a “yellow-based” red. In other words, tomato red is a red with a slight yellow-orange
cast to it. Raspberry red is a “blue-based” red, one with a slight blue cast to it. These distinctions
affect the gender-based appeal of red. In other colors, they serve to differentiate one from another.

Since the emphasis is on constructive applications of colors, positive descriptions are used for the
symbolism of each individual color. Refer back to the symbolic analysis of each color for possible

negative associations.
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— RcB Red Swatches 1-4 Name & Symbolism

Hex

R: 153 Dark Brick Red (yellow-based red)

G: 000 earthy, friendly, robust, strong, tasty, warm
B: 000

990000

R: 204 Medium Dark Red (yellow-based red)
G: 000 invigorating, powerful, zesty, tasty, spicy,
B: 000 hot

CCO0000

R: 255 Tomato Red (yellow-based red)

G: 000 dynamic, powerful, aggressive, rebellious,
B: 000 impulsive, strong, sexy, exciting, festive,
FFO000 good luck, fast, war-like, demonic, hot

R: 255 Salmon Red (yellow-based red)

G: 102 healthy, happy, tasty, friendly, cosmetic,
B: 102 warm

FF6666
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_ ReGB Red Swatches 5-8

Hex

R: 204
G: 102
B: 102
CC6666

R: 204
G: 153
B: 153
CC9999

R: 255
G: 204
B: 204
FFCCCC

R: 255
G: 000
B: 051
FFO033

Name & Symbolism

Muted Brick Red (yellow-based red)
healthy, tasty, comforting, warm

Mauve Beige
sophisticated, relaxing, cosmetic, warm

Light Warm Pink (yellow-based red)
comforting, gentle, delicate, sweet,
happy, floral, spring-like, babyish,
feminine

Bright Cherry Red
festive, dynamic, energizing, sexy,
fruity, warm

Color Voodoo #1 - A Guide to Color Symbolism




S Red Swatches 9-12

Hex

R: 153
G: 000
B: 051
990033

R: 255
G: 102
B: 153

FF6699 _

R: 204
G: 000
B: 102
CC0066

R: 255
G: 000
B: 153
FF0099

Name & Symbolism

Dark Red (blue-based red)
formal, majestic, sophisticated, elegant,
rich, warm

Deep Pink (blue-based red)
healthy, happy, fun, floral, sweet, fruity,
warm

Raspberry Red (blue-based red)
vibrant, fruity, feminine, warm

Bright Raspberry Pink
(blue-based red)
zany, electric, festive, vibrant, ecstatic,

tangy-fruity, whimsical, tropical, hot

4
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= ﬁeGXB Red Swatches 13-16
R: 255

G: 153

B: 204

FF99CC

R: 102
G: 000
B: 051
660033

R: 204
G: 051
B: 153
CC6699

R: 153
G: 000
B: 102
990066

Name & Symbolism

Raspberry Pink (blue-based red)
happy, fun, comforting, sweet, child-like,
feminine, cosmetic, spring-like, floral,
warm

Deep Burgundy Red (blue-based red)
sophisticated, aristocratic, majestic,
dignified, elegant, high quality,
expensive

Light Muted Burgundy Red
(blue-based red)

romantic, intimate, floral, tender,
feminine, cosmetic, sentimental

Deep Plum Red (blue-based red)
elegant, majestic, spiritual, fruity,
feminine
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S Red Swatches 17-19

Hex

R: 255
G: 102
B: 204
FF66CC

R: 255
G: 000
B: 255
FFOOFF

R: 255
G: 204
B: 255
FFCCFF

Name & Symbolism

Light Hot Pink (blue-based red)
happy, fun, festive, tropical, feminine,
cosmetic, floral, warm

Fuchsia/ Bright Magenta
(blue-based red)

zany, electric, festive, magical,
whimsical, exotic, tropical, hot

Light Pink (blue-based red)
happy, delicate, floral, cosmetic,
feminine, child-like, floral

The Symbolism of Red
(Text)

Purple Swatches

4
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B Purple Swatches 1-4

Hex

R: 102
G: 000
B: 102
660066

R: 153
G: 000
B: 153
990099

R: 204
G: 102
B: 204
CC66CC

R: 204
G: 153
B: 204
Cco99cCcC

Name & Symbolism

Burgundy Purple

sophisticated, aristocratic, majestic,
elegant, expensive, dignified, spiritual,
fruity

Medium Burgundy Purple
vibrant, spiritual, passionate, floral, fruity

Medium Light Burgundy Purple
romantic, cosmetic, floral, warm

Light Red Purple
spiritual, delicate, romantic, spring-like,
floral
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S Purple Swatches 5-8 Name & Symbolism

Hex

R: 102 Dark Mauve Purple
G: 051 sophisticated, elegant, philosophical,
B: 102 spiritual, artistic

663366

R: 051 Dark Purple #1

G: 000 regal, dignified, elegant, expensive,
B: 102 philosophical, intelligent, spiritual,
330066 mysterious

R: 102 Grape Purple

G: 000 sophisticated, aristocratic, expensive,

B: 153 elegant, dignified, philosophical, creative,
660099 passionate, mysterious, spiritual, fruity

R: 204 Light Grape Purple

G: 153 spiritual, romantic, spring-like, floral

B: 255

CC99FF b
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_  RGB

Hox Purple Swatches 9-12
R: 153
G: 000
B: 255
9900FF

R: 153
G: 102
B: 255
9966FF

R: 102
G: 000
B: 255
6600FF

R: 153
G: 153
B: 255
9999FF

Name & Symbolism

Bright Purple

electric, potent, aware, passionate,
vibrant, spiritual, mystical, magical,
tropical, tangy, floral

Medium Purple
spiritual, sensitive, romantic, spring-like,
floral

Ultraviolet Purple

powerful, intense, intelligent, creative,
aware, vibrant, high tech, electric,
radioactive

Medium Light Ultraviolet Purple
spiritual, meditative, tranquil
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B Purple Swatches 13-16
R: 051
G: 000
B: 153
330099

R: 204
G: 204
B: 255
CCCCFF

R: 102
G: 102
B: 153
666699

R: 153
G: 153
B: 204
9999CC

Name & Symbolism

Dark Purple #2

regal, dignified, elegant, expensive,
philosophical, intelligent, spiritual,
mysterious

Light Purple
spiritual, meditative, calming, soothing

Medium Gray Purple
dignified, intellectual, respectable,
expensive, sophisticated, creative

Light Gray Purple
philosophical, creative, sophisticated,
spiritual, peaceful
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B Purple Swatches 17-18 Name & Symbolism

Hex

R: 051
G: 000
B: 204
3300CC

Blue Purple
dignified, high tech, potent, electric,
intelligent

R: 102 Medium Blue Purple

G: 102 inspirational, spiritual, mystical, sensitive
B: 255

6666FF

The Symbolism of Purple |
(Text)

Blue Swatches }
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S Blue Swatches 1-4 Name & Symbolism

Hex

B: 255 sporty, marine, masculine, cool

O0O00FF

R: 000 Dark Navy Blue

G: 000 dignified, trustworthy, professional,

B: 102 official, intelligent, respectable, secure,

000066 sophisticated, expensive, nautical

R: 051 Cobalt Blue (purple-based)

G: 000 high tech, powerful, electric, strong,

B: 255 sporty, cool

3300FF

R: 000 Navy Blue

G: 000 dignified, trustworthy, professional,

B: 153 official, intelligent, respectable, secure,

000099 sophisticated, expensive, nautical,
masculine

R: 000 Bright Blue

G: 000 _ strong, knowledgeable, clean, high tech,

4
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B Blue Swatches 5-8
R: 000
G: 051
B: 204
0033CC

R: 102
G: 153
B: 255
6699FF

R: 051
G: 102
B: 204
3366CC

R: 153
G: 204
B: 255
99CCFF

Name & Symbolism

Blue
dependable, understanding, secure,
calming, masculine, cool

Medium Light Muted Blue

calming, soothing, understanding,
ethereal, spiritual, melancholic, marine,
light, cold

Medium Muted Blue
secure, trustworthy, understanding,
calming, cool

Light Blue
peaceful, calming, quiet, passive,
ethereal, spiritual, cool
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B Blue Swatches 9-12
R: 000
G: 102
B: 255
0066FF

R: 000
G: 153
B: 255
0099FF

R: 051
G: 102
B: 153
336699

R: 102
G: 153
B: 204
6699CC

Name & Symbolism

Medium Blue
clean, refreshing, marine, aquatic, cool

Cerulean Blue
clean, refreshing, aquatic, cool

Medium Blue Gray
dignified, dependable, professional,
respectable, intelligent, peaceful

Light Blue Gray
peaceful, intelligent, understanding,
spiritual, wintery
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B Blue Swatches 13-14
R: 000
G: 102
B: 153
006699

R: 000
G: 204
B: 255
00CCFF

Name & Symbolism

Dark Turquoise Blue
relaxing, dependable, aquatic, cool

Aqua
refreshing, clean, aquatic, cool

Blue Green Swatches }
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= ESXB Blue-Green Swatches 1-2
R: 000
G: 255
B: 255
OOFFFF

R: 204
G: 255
B: 255
CCFFFF

Name & Symbolism

Cyan

festive, whimsical, zesty, refreshing,
aquatic, clean, tropical, cool

Light Cyan

peaceful, soothing, clean, cool

The Symbolism of Blue ’

(Text)

Green Swatches }
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. Green Swatches 1-4

Hex

R: 000
G: 102
B: 102
006666

R: 000
G: 153
B: 153
009999

R: 051
G: 102
B: 102
336666

R: 153
G: 204
B: 204
99CCCC

Name & Symbolism

Teal Green
dependable, comfortable, secure, natural,

dignified, sophisticated, professional

Medium Teal Green
healthy, relaxing, soothing, refreshing,
aquatic, cool

Dark Gray Green
dignified, sophisticated, dependable,
secure, professional, peaceful

Light Gray Green (celadon)
peaceful, soothing, sophisticated,
subdued, cool
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— RGB Green Swatches 5-8

Hex

R: 000
G: 255
B: 204
OOFFCC

R: 000
G: 204
B: 153
00CC99

R: 000
G: 255
B: 153
00FF99

R: 153
G: 255
B: 204
99FFCC

Name & Symbolism

Cyan Green
refreshing, stimulating, electric, astringent
whimsical, clean, aquatic, cool

Viridian Green (blue-based)
healthy, refreshing, relaxing, aquatic, cool

Bright Green
healthy, zesty, botanical, fresh, clean,
cleansing, electric, minty, cool

Light Green
refreshing, soothing, minty, cool
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B Green Swatches 9-12
R: 000
G: 051
B: 051
003333

R: 000
G: 153
B: 102
009966

R: 102
G: 204
B: 153
66CC99

R: 000
G: 204
B: 102
00CC66

Name & Symbolism

Dark Green

dependable, dignified, professional,
respectable, secure, sophisticated,
expensive

Green #1
botanical, ecological, natural, lucky,
healthy, healing, cool

Muted Medium Light Green
healthy, relaxing, soothing, peaceful,
natural, cool

Green #2
botanical, ecological, natural, lucky, fresh,

refreshing, healthy, cool
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. Green Swatches 13-16

Hex

R: 000
G: 102
B: 051
006633

R: 153
G: 255
B: 153
99FF99

R: 204
G: 255
B: 204
CCFFCC

R: 000
G: 051
B: 000
003300

Name & Symbolism

Dark Forest Green

dependable, professional, secure,
botanical, ecological, natural, steadfast,
healthy, quiet, cool

Medium Light Green
natural, healthy, soothing, refreshing,
botanical, fresh, cool

Light Green
peaceful, soothing, healthy, refreshing,

cool

Dark Green (yellow-based)
earthy, woodsy, dependable, natural,
ecological, steadfast, secure, wise
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S Green Swatches 17-20

Hex

R: 102
G: 204
B: 102
66CC66

R: 102
G: 153
B: 102
669966

R: 153
G: 204
B: 153
99CC99

R: 000
G: 255
B: 000
00FFO00

Name & Symbolism

Muted Medium Light Green
(yellow-based)

botanical, natural, healthy, raw,
refreshing, cool

Muted Medium Light Green
(yellow-based)

natural, botanical, peaceful, dependable,
calming, cool

Light Celery Green
natural, botanical, dependable, calming,
delicate, cool

Lime Green
primordial, extraterrestrial, electric, raw,
stimulating, acidic, sour, cool

4
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— Green Swatches 21-24

Hex

R: 051
G: 102
B: 000
336600

R: 102
G: 204
B: 000
66CCO00

R: 204
G: 255
B: 153
CCFF99

R: 153
G: 255
B: 000
99FF00

Name & Symbolism

Dark Avocado Green
earthy, botanical, natural, cool

Bright Avocado Green
botanical, raw, acidic, primordial, sour

Muted Light Avocado Green
botanical, refreshing, natural, healthy,
cool

Bright Yellow Green #1
primordial, electric, astringent,
extraterrestrial, acidic, raw, sour
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. Green Swatches 25-27 Name & Symbolism

Hex

Olive Yellow Green
earthy, raw, sour

R: 153
G: 153
B: 000
999900

Muted Yellow Green

R: 153
earthy, restful

G: 153
B: 102
999966

R: 204
G: 204
B: 153
CCCC99

Light Muted Yellow Green
natural, restful, subdued

The Symbolism of Green |

(Text)

Yellow Swatches p
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Hex

R: 204
G: 255
B: 000
CCFFO00

R: 204
G: 204
B: 000
CCCCO00

R: 255
G: 255
B: 000
FFFFOO

R: 255
G: 255
B: 102
FFFF66

— RGB Yellow Swatches 1-4

Name & Symbolism

Bright Chartreuse Yellow
sour, primordial, electric, astringent, raw,
acidic

Dark Chartreuse Yellow
botanical, primordial, earthy

Yellow

joyous, vibrant, spiritual, luminous,
energizing, sunny, floral, tangy, citric,
warm

Medium Light Yellow
joyous, lively, spiritual, luminous, sunny,
summery, floral, warm
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— RGB Yellow Swatches 5-8

Hex

R: 255
G: 255
B: 204
FFFFCC

R: 255
G: 204
B: 000
FFCCO00

R: 153
G: 102
B: 000
996600

R: 204
G: 153
B: 051
CC9933

Name & Symbolism

Light Yellow
mellow, optimistic, cheerful, spring-like,
warm

Golden Yellow
radiant, cheerful, stimulating, energizing,
invigorating, sunny, floral, fruity, warm

Golden Yellow Brown
earthy, natural, healthy, woodsy,
autumnal, warm

Light Golden Tan
earthy, natural, healthy, tasty, arid,
warm
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R Yellow Swatches 9-11 Name & Symbolism

Hex

Dark Yellow Orange
zesty, spicy, tasty, healthy, invigorating,
earthy, autumnal, warm

R: 204
G: 102
B: 000
CC6600

R: 255 Yellow Orange

G: 153 stimulating, healthy, invigorating,

B: 000 energizing, happy, sunny, tasty, fruity,
FF9900 warm

R: 255 Light Yellow Orange

G: 204 cheerful, friendly, healthy, invigorating,
B: 102 sunny, warm

FFCC66

The Symbolism of Yellow ’
(Text)

Orange Swatches P
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_  RGB

Ho Orange Swatches 1-4
R: 255
G: 102
B: 000
FF6600

R: 204
G: 102
B: 051
CC6633

R: 255
G: 153
B: 102
FF9966

R: 255
G: 204
B: 153
FFCC99

Name & Symbolism

Orange

stimulating, energizing, exciting,
cheerful, fruity, autumnal, inexpensive,
warm

Terra-cotta Orange
zesty, spicy, natural, invigorating, tasty,
healthy, earthy, autumnal, warm

Light Salmon Orange
healthy, friendly, cheerful, invigorating,
tasty, warm

Light Orange

healthy, cheerful, tasty, flesh-like, healthy,

warm

4
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S Orange Swatches 5-6 Name & Symbolism

Hex

Dark Red Orange
invigorating, spicy, tasty, earthy,
autumnal, warm

R: 204
G: 051
B: 000
CC3300

Red-Orange
exciting, aggressive, invigorating, raw,
impulsive, tasty, hot

R: 255
G: 051
B: 000
FF3300

The Symbolism of Orange }
(Text)

Brown Swatches }
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. Brown Swatches 1-4
R: 102
G: 000
B: 000
660000

R: 153
G: 051
B: 000
993300

R: 153
G: 102
B: 051
996633

R: 204
G: 153
B: 102
CC9966

Name & Symbolism

Dark Red Brown
dependable, strong, robust, friendly,
natural, earthy, tasty, warm

Russet Brown
earthy, natural, tasty, spicy, autumnal,
warm

Medium Light Brown
dependable, friendly, tasty, healthy,
earthy, natural, woodsy, warm

Light Coffee Brown
earthy, tasty, friendly, natural, healthy,
warm
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e Brown Swatches 5-7 Name & Symbolism

Hex

Dark Chocolate Brown

R: 051 _
G: 000 dependable, strong, sturdy, natural, rich,
B: 000 tasty, earthy, woodsy, warm

330000

Medium Brown
dependable, relaxing, friendly, natural,
tasty, earthy, woodsy, warm

R: 102
G: 051
B: 051
663333

Mauve Brown

R: 153
relaxing, friendly, natural, tasty, warm

G: 102
B: 102
996666

The Symbolism of Brown
(Text)

Black & White Swatches }
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~ RoGB Black & White Swatches

Hex

R: 000
G: 000
B: 000
000000

R: 255
G: 255
B: 255
FFFFFF

Name & Symbolism

Black
powerful, sophisticated, strong, sexy,
magical, demonic, ominous, expensive

The Symbolism of Black P
(Text)

White
pure, spiritual, clean, sterile, truthful,
chaste, innocent, peaceful

The Symbolism of White
(Text)

Gray Swatches
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P Gray Swatches 1-2 Name & Symbolism

Hex

R: 102 Medium Gray

G: 102 dignified, intelligent, high tech, creative,
B: 102 efficient, expensive, unadorned, subtle,
666666 neutral, cool

R: 204 Light Gray

G: 204 calming, unadorned, unpretentious,

B: 204 neutral, subtle, subdued, cool

cccece

The Symbolism of Gray }
(Text)
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About the author

Jill Morton is a color consultant whose clientele include industry giants Nokia
and Kodak. She holds a Masters degree in the Fine Arts and has served as faculty
at the University of Hawaii, Chaminade University and Matsuda Technology Center.

Ms. Morton is a resident of Hawaii, the crossroads between East and West. This
multi-cultural environment has been an ongoing source of information about color
symbolism. The colorful natural landscape of the Hawaiian Islands has served as a
reference for the color associations and harmonies found in nature.

The most significant data has come from her web-based research. Since 1995, more
than 3,000 responses and 60,000 entries have been received from the Global Color
Survey, located at her educational web site, Color Matters.
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